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Appendix A

ResSim Application Settings
A.1 Working with Watershed Directories and Files

When you create a new watershed, ResSim generates a directory structure
and stores all files associated with the watershed inside that structure.

Figure A.1 illustrates a “tree

structure” that shows how ResSim E"'_E!_.H;IEEQHESSW‘W'D

organizes the folders it creates in the 5 :.al. wra

root (modeling) directory identified L maps

for your watershed. The root B0 rss

directory (e.g., HECResSim_V2.0) =7 1993.11.29-0700
contains a subdirectory named base. ----- 1 maps
When you create a new watershed, j :ﬁare 5
ResSim creates a new watershed » ™7 study
directory in the base directory. The P ™1 supplemental
watershed directory isnamed | | T scrpts

according to the name you have given | = 1 shared

the watershed. For example,in | @ . 1 study

Figure A.1, the watershed directory | = 1 supplemental

is BaldEagle. The watershed Figure A.1 ResSim Watershed
directory stores all of the base data Directory Structure

for the watershed, including maps,
schematic elements, base model data, and simulation data and results.

When you create a new simulation, ResSim generates a simulation
directory named according to the date and time of the simulation. In
Figure A.1, the directory name 7/993.11.29-0700 corresponds to a
simulation for November 29, 1993, at 07:00am. When a simulation is
created, ResSim automatically copies all of the base data for your
watershed (except for maps) into the simulation directory. This facilitates
archiving of simulation information and ensures consistency in your
model results.

If you Save to Base Directory in the Simulation Module, ResSim copies
your model alternative data from the simulation directory back to the base
directory. If you Replace From Base Directory in the Simulation
Module, ResSim copies the original model alternative data from your base
directory into your simulation directory. See Chapter 14, Section 14.7 for
more information about these commands.
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A.2 Setting Application Options

ResSim allows you to configure several options. You can specify the
model directories for your watersheds, cache directory for maps, configure
the display for the compute display, and specify debug levels.

To configure these options, select Options from the Tools menu of any
module to access the Options dialog box (Figure A.2).

HEC-ResSim Options x|
'''' S| Cache Directon-" Carnpute Display' Debuy Levels' General| Fonts'
rWiatershed Locations
Marme | Location |
Add Location ... | Remaove Location | Edit Location ... |
Ok I Cancel |

Figure A.2 HEC-ResSim Options Dialog Box

A.2.1 Setting Model Directories for Watersheds

The Model Directories tab lets you specify the working directory for
watershed data on your local computer. An example of the Model
Directories tab is shown in Figure A.3, and a detailed description is
presented in Chapter 3, Section 3.3.1.

I|HEC-ResSim Options x|

dodel Directnriesl Cache Diractory| Compute Display| Debug Levels | General| Fonts |

~Watershed Locations
Mame | Location |
CWyME demos CICWME_demos
User's Manual ¥1.1 CiHecResSim_1.1
TestBaldEagle ZIHEC-ResSim
Cldenéatersheds CIHEC-ResSim_sy
Add Location .. Remaove Location | Edit Location ... |

Ok |

Figure A.3 Options Dialog Box, Model Directories Tab
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A.2.2 Setting the Cache Directory

The Cache Directory is pertinent when running ResSim in a “client-
server” mode (not applicable for standalone version of ResSim). The
cache directory is the location on your computer where ResSim
copies background maps for a watershed so they aren’t downloaded
from the server each time you access the watershed.

To specify the cache directory on your local computer, select the
Cache Directory tab in the Options dialog box (Figure A.4). After
clicking in the Use Cache box, you can either type in a directory path
or click the Browse button to find the directory you want.

{HEC-ResSim Options Ed

Model Directories  Cache Directuryl Compute Display| Debug Levels| General| Forts|

— W Use Cache

Cache Directary: Browse... |

6] 54 I Cancel

Figure A.4 Options Dialog Box, Cache Directory Tab

A.2.3 Configuring the Compute Display

When you compute a simulation in the Simulation Module, the
Compute Display window reports on the progress of the model and
presents warning and error messages generated by the model. The
Compute Display tab of the Options dialog box (Figure A.5) allows
you to configure the appearance of the Compute Display window.
You can configure the Compute Display to present logs as HTML
(web pages), specify a background color for HTML, and specify the
text colors for compute messages, warnings, and errors.
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I|HEC-ResSim Options x|

Model Directnries' Cache Directory  Compute Displavl Debug Levels' General' ants'

rZompute Window Properies:

Compute Message Caolar: IElIack vI
Compute Warning Message Caolar: IYEIIDW vI

Compute Error Message Colar Fed -

~Log File Fropeties:

[ Use HTML for Logs

HTML Background Color: IWhite vI

(0]14 I Cancel

Figure A.S Options Dialog Box, Compute Display Tab

A.2.4 Specifying Debug Levels

You will use the Debug Levels tab of the Options dialog box (Figure
A.6) primarily when you need technical support. With this tab, you
can specify the level of detail for problem tracking. Higher numbers
in the Level column specify more detail in debug reporting.

"|HEC-ResSim Options Ed

Model Directories | Cache Directory| Compute Display  Debug LEVE|S| General | Fonts |

Log Flag | Level

scripting
preferences
Gricd il
plotDefaults
units
ResSimOperations
maps
rmiworkspace
dataTypeFactory
parametars
fileLocking

mimim|m| M| ||| g
4

QK I Cancel

Figure A.6 Options Dialog Box, Debug Levels Tab
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A.2.5 Setting General Options

Use the General tab of the Options dialog box (Figure A.7) to specify
whether ResSim shows a confirmation message when you exit the
program and/or whether to load the last Watershed when you start the
program.

I|HEC-ResSim Options Ed

Madel Directoriesl Cache Direcmwl Compute Displavl Debug Levels Generall ants'
Settings:

v Show Confirm On Exit

™ Reload lastWatershed at Startup

(0]24 I Canceal

Figure A.7 Options Dialog Box, General Tab

A.2.6 Specifying Fonts

Use the Fonts tab of the Options dialog box (Figure A.8) to specify
the font that will be used for a variety of components in the display.
These components include: Tabs, Labels, Descriptions for Radio
Buttons and Checkboxes, Buttons, Lists and Textfields.

I|HEC-ResSim Options
MDdeIDirectariesl Cache Directur\,rl Compute Displayl Debug Levelsl General FanSl

Sample Components
ATah | AaBbCc 123
T¥pe [Dialog -
A Label A RadioButtan ! =l
™ Bold [Sample text
A Button | [" A Checkbox I Italic “AaBbCHEB
[tern one =] faTextFiel Size
’V _} | 1z
Set Font Selection | Reset Font Selection |

Ol I Cancel |

Figure A.8 Options Dialog Box, Fonts Tab
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A.3 Viewing Application Properties

The Application Properties dialog box will be of assistance if you need
to seek technical support. Similar to a File>Properties dialog box in a
Windows application, the Application Properties dialog box provides
details about your ResSim setup. These details include information about
your local computer (your ResSim root directory, whether you are
working in local or networked mode, and the IP address of your
computer); your unique user properties (your user ID, user name, login,
user directory path, preference directory, and access levels); watershed
properties for the watershed you are viewing; server properties
(application server, File manager, and login server); and system
properties.

To access the Application Properties dialog box, choose Information
from the Tools menu of any ResSim module.

A.3.1 Viewing Client Properties

The Client Properties tab of the Application Properties dialog box
(Figure A.9) displays information about your local computer’s setup.
The directory shown as Base Directory is your root directory for
your watershed (as previously described in Sections A.1 and A.2.1).
The Mode indicates whether you are working locally on your PC or
are connected to a network in “client-server” mode. The Port and
Client URL information are not applicable for the local mode of
ResSim. The “client-server” mode is not described in the
documentation for ResSim.

Il Application Properties E3

le Userl Watershedl Ber\.ferl Systemn Prnpeniesl

Fort: TR,

Basze Directory: C/HecResSim_1.1
Mode: Laocal

Client URL: (RN

Close

Figure A.9 Application Properties Dialog Box, Client Tab
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A.3.2 Viewing User Properties

The User tab of the Application Properties dialog box (Figure A.10)
is primarily used for displaying CWMS “client-server” information,
such as your user ID, user name, login, user directory, user preference
directory, and user types (access levels).

il Application Properties

Client ; /S&r: Watershedl Benrer| System F'rnpertiesl
LiserID: g0hecmbh
Llser Kame: gOhecmbh
Login: glhecmbh

Llser Directany:
User Preference Directory. JusersigDhecmbhidllipreferences

User Types: Maone

Close

Figure A.10 Application Properties Dialog Box, User Tab
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A.3.3 Viewing Watershed Properties

The Watershed tab of the Application Properties dialog box (Figure
A.11) displays details about the currently opened watershed, and
includes the Watershed Name, directory Path, Watershed Units, and
Watershed Time Zone. Watershed Monetary Units is in development
for later versions of ResSim. The Watershed Coordinate System
being used is also displayed. The Current Watershed Users is
pertinent for CWMS “client-server” mode and is not described in the
ResSim documentation.

Il Application Properties X

Clientl Usar Watershed' Ser\rerl System Prnper‘[iesl

Watershed MName: BaldEagleDerma

Watershed Path: CiHecRes5im_1.1/base/BaldEagleDemo
Watershed Linits: English

Watershed Timezane: GMT -5:00

Watershed Monetary Lnits:
Watershed Coordinate Systerm:  State Plane Coordinates
Current Watershed Users: qihecmbh

Close

Figure A.11 Application Properties Dialog Box,
Watershed Tab

A.3.4 Viewing Server Properties

The Server tab of the Application Properties dialog box (Figure A.12)
is pertinent for CWMS “client-server” mode and is not described in
the ResSim documentation.

I| Application Properties x|

rI System Prnpeniesl

App Server URL: i
FileManager URL: i

LoginSener LIEL: kA

Close

Figure A.12 Application Properties Dialog Box,
Server Tab
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A.3.5 Viewing and Editing System Properties

You will only need to use the System Properties tab of the
Application Properties dialog box (Figure A.13) for debugging
purposes. Although you can view this tab, editing properties is not
recommended.

ij You must be extremely careful when making changes to

the System Properties, as they directly affect ResSim’s
functionality.

il Application Properties B4

Client | User | Watershed | Server | System Properties |

CWWMS_HOME= -

SYSTEM_FREFEREMCES=Jusers/CiWhS

LISERS_DIRECTORY=Iusers

LISER_PREFEREMCES=fusersigOhecmbh

awttoolkit=sun.awt.windows WToolkit

file.encoding.pky=sun.io

file.encoding=Cp1 242

file.separator=\

java.awtoraphicsem=sun.awt Wind2GraphicsEnvironment

java. awt printeriob=sun. awt windows WPrinterdob

java.class.path:janwcds.jar;jangnesit.jar;janhec.jar;janrma.jar;janras.j_arlll
»

IR —

[ [=3T Edit ... Delete |

Close

Figure A.13 Application Properties Dialog Box, System Properties
Tab

If you absolutely need to edit the properties, highlight the property to
edit and click the Edit button. The Edit System Property dialog box
will open (Figure A.14), allowing you to type in the Property name
and Property Value. Note that only certain properties are editable.

Edit Syztem Property

Property. |USER_PREFERENCES]

Praoperty alue: | jusersigdhecmbh

%
cancel_|

Figure A.14 Edit System Property Dialog Box

A-9
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You can also add system properties by clicking the New... button.
The New System Property dialog box will open (Figure A.15),
allowing you to enter a new Property name and Property Value.

Mew System Property
Propey: ||
Froperty Value: |

Figure A.15 New System Property Dialog Box

You can also Delete System Properties but it is not recommended to
do so.




